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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified 
personnel are those who, based on their training and experience, are capable of identifying risks and avoiding 
potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in 
this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
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Foreword

SINUMERIK documentation 
The SINUMERIK documentation is organized into the following categories:

● General documentation/catalogs

● User documentation

● Manufacturer/service documentation

Additional information
You can find information on the following topics at the following address (https://
support.industry.siemens.com/cs/de/en/view/108464614):

● Ordering documentation/overview of documentation

● Additional links to download documents

● Using documentation online (find and search in manuals/information)

If you have any questions regarding the technical documentation (e.g. suggestions, 
corrections), please send an e-mail to the following address 
(mailto:docu.motioncontrol@siemens.com).

mySupport/Documentation
At the following address (https://support.industry.siemens.com/My/ww/en/documentation), 
you can find information on how to create your own individual documentation based on 
Siemens' content, and adapt it for your own machine documentation.

Training
At the following address (http://www.siemens.com/sitrain), you can find information about 
SITRAIN (Siemens training on products, systems and solutions for automation and drives).

FAQs
You can find Frequently Asked Questions in the Service&Support pages under Product 
Support (https://support.industry.siemens.com/cs/de/en/ps/faq).

SINUMERIK
You can find information about SINUMERIK at the following address (http://www.siemens.com/
sinumerik).
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Security information on the product

Note
SINUMERIK Integrate 

The SINUMERIK Integrate product is available as standalone (intranet) version or in cloud 
operation (ASP).
● Standalone (intranet):

Read and write access to the file system and resources of the operating system of the 
SINUMERIK Integrate server is enabled only for users with administrator rights.

● Cloud mode (ASP):
Siemens AG as operator ensures the security of the SINUMERIK Integrate server. 
Customers must only ensure the security of the infrastructure on the machine side.

Further information about server operation can be found at Industrial Security Configuration 
Manual (https://support.industry.siemens.com/cs/us/en/view/108862708).

NOTICE

Misuse of data

It is essential to use secure data storage when saving your data - particularly your confidential 
data. It is best to store this data encrypted locally or encrypted on the network. Make sure 
that this data cannot be accessed by unauthorized personnel.

This applies to the following data:
● Archive files
● Image files
● Project files
● Trace files
● Safety-relevant files

Further information on secure data storage can be found at Industrial Security Configuration 
Manual (https://support.industry.siemens.com/cs/us/en/view/108862708).

NOTICE

Danger due to insecure Internet connection 

Before establishing a network connection, ensure your PC is connected to the Internet via a 
secure connection. Pay attention to the security-relevant notes. Further information about 
communications security can be found at Industrial Security Configuration Manual (https://
support.industry.siemens.com/cs/us/en/view/108862708).

Foreword
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NOTICE

Security risk through administrator rights

If you operate a PC with permanent administrator rights, there is an increased security risk. 
Therefore, ensure that there is a secure operating environment, and assign administrator 
rights only temporarily and selectively.

Further information on the secure administration of user accounts and the assignment of 
rights can be found at Industrial Security Configuration Manual (https://
support.industry.siemens.com/cs/us/en/view/108862708). 

Target group
The operating manual is aimed at all machine tool users. The document provides information 
that users require to understand the SINUMERIK Integrate software.

Benefits
The operating manual allows the target group to get familiar with the software user interface. 
Based on the manual, the target group is capable of responding to problems and to take 
corrective action.

Standard scope
This documentation describes the functionality of the standard scope. Additions or revisions 
made by the machine manufacturer are documented by the machine manufacturer. 

Other functions not described in this documentation might be executable in the control system. 
This does not, however, represent an obligation to supply such functions with a new control 
or when servicing.

Furthermore, for the sake of clarity, this documentation does not contain all detailed information 
about all product types and cannot cover every conceivable case of installation, operation or 
maintenance. 

Foreword
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Fundamental safety instructions 1
1.1 General safety instructions

WARNING

Danger to life if the safety instructions and residual risks are not observed 

If the safety instructions and residual risks in the associated hardware documentation are not 
observed, accidents involving severe injuries or death can occur.
● Observe the safety instructions given in the hardware documentation.
● Consider the residual risks for the risk evaluation.

WARNING

Malfunctions of the machine as a result of incorrect or changed parameter settings

As a result of incorrect or changed parameterization, machines can malfunction, which in turn 
can lead to injuries or death.
● Protect the parameterization (parameter assignments) against unauthorized access.
● Handle possible malfunctions by taking suitable measures, e.g. emergency stop or 

emergency off.

Analyze MyCondition (AMC), Access MyMachine/Ethernet (AMM/E)
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1.2 Warranty and liability for application examples
The application examples are not binding and do not claim to be complete regarding 
configuration, equipment or any eventuality which may arise. The application examples do not 
represent specific customer solutions, but are only intended to provide support for typical tasks. 
You are responsible for the proper operation of the described products. These application 
examples do not relieve you of your responsibility for safe handling when using, installing, 
operating and maintaining the equipment.

Fundamental safety instructions
1.2 Warranty and liability for application examples
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1.3 Industrial security

Note
Industrial security

Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines and networks.

In order to protect plants, systems, machines and networks against cyber threats, it is 
necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial 
security concept. Siemens products and solutions only represent one component of such a 
concept.

The customer is responsible for preventing unauthorized access to its plants, systems, 
machines and networks. Systems, machines and components should only be connected to 
the enterprise network or the internet if and to the extent necessary and with appropriate 
security measures (e.g. use of firewalls and network segmentation) in place. 

Additionally, Siemens’ guidance on appropriate security measures should be taken into 
account.  For more information about industrial security, please visit:

Industrial security (http://www.siemens.com/industrialsecurity).

Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends to apply product updates as soon as available and to always 
use the latest product versions. Use of product versions that are no longer supported, and 
failure to apply latest updates may increase customer’s exposure to cyber threats. 

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS 
Feed at:

Industrial security (http://www.siemens.com/industrialsecurity).

WARNING

Unsafe operating states resulting from software manipulation

Software manipulations (e.g. viruses, trojans, malware or worms) can cause unsafe operating 
states in your system that may lead to death, serious injury, and property damage.
● Keep the software up to date. 
● Incorporate the automation and drive components into a holistic, state-of-the-art industrial 

security concept for the installation or machine.
● Make sure that you include all installed products into the holistic industrial security concept.
● Protect files stored on exchangeable storage media from malicious software by with 

suitable protection measures, e.g. virus scanners.

Fundamental safety instructions
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Overview 2
2.1 Introduction

What is SINUMERIK Integrate?
SINUMERIK Integrate supports the maintenance, service, production planning and production 
of machine tool manufacturers and manufacturing companies. This is done using software 
services that are available both on the CNC and on the PC. 

This requires both Internet access and a control system on the CNC that complies with the 
specifications. Further, a factory-wide network must be set up for the applications and Internet 
access must be provided for the AMC and AMM/E applications. 

The following services, for example, are part of SINUMERIK Integrate:

SINUMERIK Integrate Analyze MyCondition 
Analyze MyCondition (AMC) provides test cycles for equability, circularity and universal axis 
tests. The test parameters can be defined centrally and configured with appropriate warning 
limits. Further, using a series of measurements, trends can be identified and these can be 
utilized as basis to optimize maintenance and service activities. 

In addition, Analyze MyCondition offers a continuous acquisition of data in the manufacturing 
process. It also supports the reporting of parameters about wear and tear of mechatronic 
components. 

The current machine status is documented using the following events and data: 

● Alarms, PLC events, time intervals, combinations of machine signals 

● Violation of the limit value and exceeding the interval value 

● Measuring/test series and utilization monitors 

● Manual help request by the machine operator in the event of faults 

● HMI action log, machine data, NC status data 

● PLC trace, PLC data blocks 

● Certain files (e.g. log files) of the control system 

Notifications via e-mail or through service cases initiate service and maintenance procedures. 
Maintenance activities are planned, monitored and documented directly on the machine. The 
notifications can respond to all event sources.

Note
SMS notification not possible

SMS notification is not possible in local operation!

Analyze MyCondition (AMC), Access MyMachine/Ethernet (AMM/E)
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SINUMERIK Integrate Access MyMachine/Ethernet 
In the event of a fault, SINUMERIK Integrate Access MyMachine/Ethernet (AMM/E) gives the 
machine manufacturer's service organization fast access to important machine control data 
and diagnostic functions. In that way, the machine manufacturer or maintenance department 
of the end user can immediately analyze the current condition of the machine in which a fault 
occurred. 

Remote access to the control system is via a secure Internet infrastructure and allows the 
exchange of information and remote control of the CNC. 

● Remote access 

● File transfer 

● Conference call 

● Recording of a remote access 

● Remote STEP 7

Overview
2.1 Introduction
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2.2 Product overview

Overview of the applications
As a whole, applications are available that completely cover all aspects of integrating machines 
into your communication, engineering and production processes.

Harmonized to address your particular requirements, you can access the following applications 
of SINUMERIK Integrate:

Figure 2-1 Overview

Delivery format
The latest packages and further information on the applications are stored on PridaNet and 
can be downloaded directly from there.

Client setup directory 
The client setups can be found in the following directories:

AMC
Sinumerik_Integrate_Clients > SinInt > Operate > Version > Linux/Windows

or

Sinumerik_Integrate_Clients > SinInt > HMI_Advanced

AMM/E 
The AMM/E Service Client Setup is located in the following directory: 

Sinumerik_Integrate_Clients > AMM > AMM-ServiceClient-MO 

Overview
2.2 Product overview
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Regular software updates
The security patches regularly supplied by Microsoft are checked by the Cloud mode (ASP) 
operator for compatibility with the current version of SINUMERIK Integrate by way of an internal 
system test and are then released. An overview of the patch compatibility is generally given 
shortly after the release of the security patch on the Service & Support Portal of Siemens 
Industry Automation and Drive Technologies.

Additional software 
SINUMERIK Integrate additionally uses the following software:

Software that was developed for "OpenSSL" to use the "OpenSSL Toolkit" (http://
www.openssl.org/).
Software that was developed for "Openevidence" to use the "OpenEvidence Toolkit" (http://
www.open-evidence.com/about/).

Cryptographic software written by Eric Young (eay@cryptsoft.com).
Software written by Tim Hudson (tjh@cryptsoft.com).

Software developed by Bodo Moeller.

Example: Remote access Access MyMachine (AMM/E)

Figure 2-2 Overview AMM/E

Overview
2.2 Product overview
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Analyze MyCondition (AMC) 3
Analyze MyCondition (AMC) provides test cycles for testing synchronous axes and universal 
axes and for performing circularity tests, and also offers functionality for individual acquisition 
of CNC data.

The current machine status is acquired and documented on the basis of predefined, 
standardized tests and continuous recording of status parameters (traverse path, traverse time 
and traverse operations for one axis). The test parameters can be defined centrally and 
configured with appropriate warning limits. 

Delivery stages 

Stage 1: Control system monitors
You can configure triggers that will initiate a specific action. For example, they can be 
configured to send an e-mail to the machine manufacturer’s service organization in response 
to a specific event. 

Stage 2: Diagnostics data
In addition to the triggers from stage 1, diagnostics data can be gathered and sent to the 
machine manufacturer’s service organization.

Stage 3: Maintenance functions
In addition to the functions from stages 1 and 2, the functions supplied with stage 3 can be 
used to set up and evaluate event-driven maintenance functions.

References
A description of the individual AMC functions is provided in the "SINUMERIK Integrate AMC" 
Function Manual.

Analyze MyCondition (AMC), Access MyMachine/Ethernet (AMM/E)
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Access MyMachine/Ethernet (AMM/E) 4
4.1 Introduction

Overview
In the "Machine information" > "Remote access" > "Execute remote access" tab you can 
perform efficient and low-cost support for machine tools and production equipment via the 
Internet.

In the event of a fault, the service organization of the machine manufacturer has fast access 
to important control data and diagnostic functions. In that way, the machine manufacturer or 
maintenance department of the end user can immediately analyze the current condition of the 
machine in which a fault occurred. 

Remote access avoids time-consuming on-site service assignments or helps prepare them 
better. Machine manufacturers can reduce their warranty costs while providing more efficient 
service support for their end users.

Options
● Control with SINUMERIK Operate, see Chapter: Participating in a session with SINUMERIK 

Operate (Page 26)

● PCU 50 control with HMI-Advanced, see Chapter: Participating in a session with HMI-
Advanced (Page 29)

● Machine PC, see Chapter: Participating in a session with machine PC (Page 32)

Note
For PC

If there is no current client installed on the controller, you must install or update the client via 
the "Update Teleservice" softkey before participating in a session. 

After the installation or the update, the control must be restarted.

Analyze MyCondition (AMC), Access MyMachine/Ethernet (AMM/E)
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4.2 Setting up a session

Requirement
● The necessary client software has already been installed on the PCU or the PC.

● The connection to the machine has been established.

References
For information about the installation of the current software, refer to the "Analyze MyCondition 
(AMC), Access MyMachine/Ethernet (AMM/E)" Installation Manual.

User roles
You can participate in a session with the following roles:

1. Conference owner (SE, service engineer)

2. Machine operator (MO, SINUMERIK Operate, HMI-Advanced)

3. Observing service engineer in the conference (SE, service engineer)

These user roles can have different states and are defined on the user interface with different 
icons:

Icon No. Role Status
1 Owner The conference owner participates actively in the session.

2 Owner The conference owner is active and leads the session (desktop 
sharing).

3 Machine operator The machine operator participates actively in the conference.

4 Machine operator The machine operator leads the conference. The owner does not 
control the remote desktop.

5 Machine operator The machine operator was at the conference, but is currently not 
present.

6 Observing service 
engineer

The observing service engineer participates actively in the session.

7 Observing service 
engineer

The observing service engineer was at the conference, but is cur‐
rently not present.

Overview

Table 4-1 Execute remote access

 Description
Conference data
Session number Shows the session number of the conference.

The service engineer transfers the number to all participants in the con‐
ference.
Notification of the session number is via phone, SMS, e-mail, etc. 

Access MyMachine/Ethernet (AMM/E)
4.2 Setting up a session
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 Description
Machine ID Shows the name of the machine.
Status Displays current information for the session.
Organization Shows the organization of the connected machine.
Participants 
Name Shows names and configuration of the participants. 

The icon shows the role of the participant.
Status Shows the current role of the participant.
Organization Shows the organization of the current user.
Remote access Shows a remote access.

Is only displayed for the machine operator.
Shows a terminated participant access.

Shows that the function to end remote access is not available because 
desktop sharing has not been started. In this state, no function can be 
performed via the button.

File transfer Shows the data transfer.
Is only displayed for the machine operator.

Remote STEP 7 Shows the connection via Remote STEP 7.
Is only displayed for the machine operator.

Transfer of leader‐
ship

Shows the transfer of leadership.
Is only displayed for the observing service engineer.

Table 4-2 Status bar

Icon Description
Operating mode of the application - currently only the machine operator (MO).

Shows an active remote access.

Shows an active file transfer.

Shows a recording of a session.

Shows no participation in the conference. 

Participation in a conference has been performed. 

The conference has been interrupted because of a network error. 

Access MyMachine/Ethernet (AMM/E)
4.2 Setting up a session
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Starting remote access as session leader
1. Select the "Execute remote access" function in the "Machine information" → "Remote 

access" tab. 

Figure 4-1 Execute remote access

2. The "Access MyMachine Service Client" window opens and a session number is assigned.

Figure 4-2 Session number

Access MyMachine/Ethernet (AMM/E)
4.2 Setting up a session
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3. The machine operator is then requested to grant permission. 

4. After the session has been successfully established, inform the other participants (machine 
operators, service engineers) about the session number so that they can participate in the 
conference. 
When the session establishment is completed and further participants have joined the 
session, the session data and information on the participants is displayed. 

Figure 4-3 Session started

Access MyMachine/Ethernet (AMM/E)
4.2 Setting up a session
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Observing participation
As an observing participant, you can only log in when a service engineer is already leading 
the session on a PC and the machine operator is participating on the control.

1. Under "Remote access", select the "Conference call" function. 

Figure 4-4 Conference call

2. Enter the session number that you have received from the service engineer leading the 
conference. 
Click "OK" to confirm the entry.

Figure 4-5 Enter session number

3. The "Access MyMachine Service Client" window opens and the session is established.

Figure 4-6 Observing participant of a session

Contrary to the conference leader, as observing participant you cannot call individual 
functions or end the session. For this reason, the relevant buttons and icons are not active 
in the window. 

Failed login attempt
If a machine operator has not logged in to the control, you receive the following error message:

"The service engineer or the machine operator is currently not present! Please try again later!"

Access MyMachine/Ethernet (AMM/E)
4.2 Setting up a session
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- OR -

"The session number is invalid - please check the correct notation."

1. Inform the service engineer leading the conference about the error message. 

2. Try to log in again later. 

Leaving the session
Call the "Conference > Leave" menu to leave a session in progress.

As long as the session is still in progress, you can log in and participate at any time with the 
same session number.

Access MyMachine/Ethernet (AMM/E)
4.2 Setting up a session
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4.3 Participating in a session with SINUMERIK Operate

Procedure
1. Start "SINUMERIK Integrate" on the control.

2. In the "Fault services" section, press the "Select" softkey.
The "Fault Services" window opens.

3. In the "Remote access" section, press the "Select" softkey.

Figure 4-7 Setting-up remote access with SINUMERIK Operate

Access MyMachine/Ethernet (AMM/E)
4.3 Participating in a session with SINUMERIK Operate
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4. The "SINUMERIK Integrate - Access MyMachine" window opens.
In the "Session number" field, enter the number provided by the service engineer on the 
PC, e.g. per phone. 
Press the "OK" softkey to confirm your entry.
The session is established.

Figure 4-8 Entering the session number

5. Once the session between the PC and SINUMERIK Operate has been successfully set up, 
the participants are shown.
Press the "Leave session" softkey to end access to the control.
As long as the session is not closed from the PC, you can participate in a session as often 
as required using the same session number. 

Figure 4-9 Remote access active 
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Figure 4-10 Remote access active - further participant

Result
After the participants have registered at the control, they are also displayed on the PC. 

You can also use the "File transfer" and "Desktop sharing" functions on the PC. 

Remote STEP 7 (RS7) is only available with SINUMERIK Operate (Linux).

Further information on the required versions of SINUMERIK Operate and SIMATIC Manager 
can be found in the "Supplementary Conditions" document.

Figure 4-11 Remote access conference call
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4.4 Participating in a session with HMI-Advanced

Procedure
1. Start "SINUMERIK Integrate" on the control. 

2. In the "Fault services" section, press the "Select" softkey.
The "Fault Services" window opens. 

3. In the "Remote access" section, press the "Select" softkey.

Figure 4-12 HMI-Advanced remote access
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4. The "SINUMERIK Integrate - Access MyMachine" window opens.
In the "Session number" field, enter the number provided by the service engineer on the 
PC, e.g. per phone. 
Press the "OK" softkey to confirm your entry.
The session is established.

Figure 4-13 Entering the session number

5. Once the session between the PC and the control has been successfully established, the 
participants are displayed.
Press the "Exit session" softkey to end access to the control.
As long as the session is not closed from the PC, you can participate in a session as often 
as required using the same session number. 

Figure 4-14 Remote access active 
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Result
After the participants have registered at the control, they are also displayed on the PC. 

You can also use the "File transfer" and "Desktop sharing" functions on the PC. 

Figure 4-15 Remote access conference call
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4.5 Participating in a session with machine PC

Procedure
1. Start AMM SC in service mode via the Windows Start menu: "Start" > "Programs" > 

"Siemens" > "SINUMERIK Integrate" > "Access MyMachine Service Client (AMM SC)". 
- OR -

2. Start AMM SC via the desktop link by double-clicking the following icon.
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3. The Welcome window is displayed.
Enter the "User name", "Password" and "Organization" to log in to the conference. 
Click "OK" to start the session set-up.

Figure 4-16 Welcome window

4. The "Access MyMachine Service Client" window then opens.
In the "Session number" field, enter the number provided by the service engineer on the 
PC, e.g. by phone. 
All participants in the conference are displayed under "Participants".

Figure 4-17 Log in for the conference
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Figure 4-18 Conference participants
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4.6 Remote operation using the keyboard

Available function keys
Special function keys on the operator keyboard can also be operated using the keyboard of 
the service PC via remote access. The following table shows the keys on the PC to which the 
horizontal and vertical softkeys and the special keys of the SINUMERIK keyboard are mapped.

Figure 4-19 Special keys

Key Description
Area switchover key
You can call the main menu from any operating area by pressing this key. Press‐
ing the key twice in succession changes from the current operating area to the 
previous one and back again.
Menu forward key
Expansion of the horizontal softkey bar in the same menu.

Menu back key
Return to the higher-level menu; a dialog is closed with this key.

"Machine" operating area 
Direct branch to the "Machine" operating area.

Softkeys and function keys
You can operate AMM SC via softkeys or function keys, see Chapter Calling the help 
function (Page 62)
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4.7 Using functions

4.7.1 Overview of the functions
The following functions enable diagnostics to be performed and faults to be corrected via the 
control. It is up to the service engineer to execute the functions for all problems via remote 
access on a PC with a mouse and keyboard.

So that you can use the actions, you must activate the functions in AMM/E.

Further information can be found in the Commissioning Manual SINUMERIK Integrate AMC, 
AMM/E, Chapter: Configuring Access MyMachine/Ethernet (AMM/E), activating functions

Functions

Function Description
Screen enable Permits the display and remote operation of a control. For safety rea‐

sons, however, it is not possible to initiate machine movements or to 
start NC programs.
See Chapter: Screen enable (Page 36)

File transfer Enables the transfer of one or more files or directories. Transfer can be 
from the workplace PC to the control or vice versa. This allows, for ex‐
ample, patches to be imported for the error correction. The control can 
also be updated quickly. Even complex NC programs are transferred to 
the service engineer for offline testing or for modification via file transfer.
See Chapter: Performing the file transfer (Page 41)

Remote STEP 7 With STEP 7, the control tasks can be implemented based on the SI‐
MATIC S7 automation systems.
See Chapter: Remote STEP 7 via the Internet (Page 50)

Conference call Allows several service engineers to participate in a conference. You ei‐
ther participate with an observing role or as leader of the conference. 
See Chapter: Transferring the conference leadership (Page 54)

Automatic recording of the 
meeting

Enables the session to be recorded and stored on the server as an event 
entry.
See Chapter: Downloading/deleting the session recording (Page 56)

4.7.2 Screen enable
As conference owner, you can use the screen enable (desktop sharing) to control the display 
and remote control of a control from the PC. 

Observing participants cannot participate actively in the actions.

Access MyMachine/Ethernet (AMM/E)
4.7 Using functions

Analyze MyCondition (AMC), Access MyMachine/Ethernet (AMM/E)
36 Operating Manual, 06/2017, A5E33520373B-AE



Requirements
● The connection between the PC and the control has been established. 

● The machine operator participates actively in the session.

● The "Screen enable" function is active
Further information can be found in the Commissioning Manual SINUMERIK Integrate 
AMC, AMM/E, Chapter: Configuring Access MyMachine/Ethernet (AMM/E), activating 
functions
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Procedure
1. Click the "Desktop sharing" icon to access the controller via remote access.

 

Figure 4-20 Starting desktop sharing

Via the option settings you specify for the control that remote access to the control is only 
permitted with confirmation by the machine operator. If remote access is restricted in this 
way, the machine operator receives the following message: 

Figure 4-21 Granting permission 

2. The machine operator clicks "No" to deny access.  
The remote user cannot control until the machine operator allows access. 
As long as there is no access permission, the remote user is shown the following symbol: 

Figure 4-22 Waiting for confirmation

3. Once permission has been granted, the user interface of SINUMERIK Operate or HMI-
Advanced is displayed on the PC. 
It is now possible to work on the control via remote access.
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Figure 4-23 Remote access active

Note

If remote control is already active, a second screen enable cannot be started on the same 
machine within the existing session.

Scaling the screen window 
If you change the window size, the remote screen window is also scaled. 

When the remote access is ended, the position and size of the window is saved. If the function 
is opened again in the same session, the window is restored with the same dimensions.

Ending the session 
The session can be ended by the various participants in different ways: 

● If the session leader ends the session, all participants on the control receive the following 
message: "Conference ended".
The other participants receive the following message: "The session has been ended by the 
owner", see also Chapter: Ending the session (Page 65)

● If an observing participant ends the session, the session remains active and only the 
observer's window closes. The participant can join the active session again at any time.

● If the machine operator on the control leaves the session, the session remains active for 
all other participants. Only the remote control functions are deactivated. 

Ending the session from the PC 
As remote user, click the  icon to end the session.
 - OR -

Access MyMachine/Ethernet (AMM/E)
4.7 Using functions

Analyze MyCondition (AMC), Access MyMachine/Ethernet (AMM/E)
Operating Manual, 06/2017, A5E33520373B-AE 39



Select the "End session" function in the "Actions" selection box. 

A confirmation prompt is displayed.

● Click the "No" button if you do not want to leave the conference.

● Click the "Yes" button if you want to leave the conference.

Figure 4-24 Ending the session

Leaving the session from the control 
Press the "Leave session" softkey to end access to the control.
As long as the session has not been closed from the PC, you can participate in the session 
as often as required using the same session number. 

Note

Only the service engineer at the PC can close the session. 
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Figure 4-25 Remote access active

4.7.3 Performing the file transfer
You can use the "File transfer" function to transfer files or file directories between the PC and 
the control. 

Prerequisite
● The connection between the PC and the control has been established. 

● The machine operator participates actively in a session.

● The "File transfer" function is updated.

Important icons

Icon Description
Opens the higher level in the directory tree.

Updates the view of the directory tree.
The directory list is only updated when other actions, such as navigation, copying, renam‐
ing or deleting, have been performed. 
If the machine operator makes changes to the directory tree outside of the remote access, 
the session leader must update the view.
Creates a new subdirectory in the selected directory level. 
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Display of file details
In the"File Transfer" window, the following file properties are displayed in the column view in 
both the Windows and the Linux file systems:

● File size

● Date of the last change

● Attributes

The position and size of the window are saved when the window is closed. If the function is 
opened again, the window is restored with the same dimensions. 

You can set the column width and position, but this is not saved.

Starting file transfer
1. Click the "Open file transfer" icon to start the file exchange.

 

Figure 4-26 Opening the file transfer

2. The "File Transfer" window is displayed once the function has been established. 
You can now transfer files from your PC (local file system) to another PC (remote file 
system) or vice versa.

3. Use the cursor to navigate to the required files. 

4. Some directories and files are protected. If you do not have sufficient access rights, the 
message "Access denied" is displayed.
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5. Select the required files or directories, e.g. locally on your PC or on the file system of 
another, remote PC. 

Figure 4-27 Selecting files
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6. Copy the selection via the icons /  icons to the appropriate directory.
No other actions can be performed during the copying procedure.

Note

The data transfer can be aborted by the machine operator. In this case, the message "File 
transfer aborted!" is displayed.

Note

If a directory or a file already exists in the target system, the following prompt is displayed: 
"Remote path already exists! Do you want to overwrite it?" 

The source and target directories are also displayed. 

Confirm this message with "OK". 

If you no longer want to receive such messages, activate the "Use on all in the operation!" 
checkbox before confirming.

The operation is displayed on a progress indicator.

Figure 4-28 Progress bar

7. The machine operator at the control must now grant permission for the file exchange.

– The transfer is started by pressing the "Yes" softkey.

– The transfer is rejected by pressing the "No" softkey. 

The machine operator at the control can also grant permission for all other actions during 
the current session.
The "Grant permission for all actions during this session" checkbox must be activated.

Figure 4-29 Accept file transfer
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Note
Granting permission for all actions

The machine operator can grant permission for all actions of the current session for each 
confirmation prompt at the machine. If the checkbox is activated and the operation 
confirmed with "Yes", the machine operator's permission is generally no longer required. 
This confirmation is valid for all prompts for the functions: 
● Screen enable
● File transfer
● STEP 7 via Internet
● Automatic recording of the meeting

The machine operator's permission is no longer required.

Confirming the file transfer on the machine PC
The machine operator is then requested to grant permission. A message window is displayed. 

If the remote access with file transfer is to apply for the whole session, the machine operator 
activates the "Use this decision for the entire session" checkbox before permitting remote 
access with "Yes".

Note
No permission for the entire session

If the machine operator does not grant general permission for all of the actions for the entire 
session, the service engineer has no remote access during the time when the confirmation 
prompts are displayed on the machine. The service engineer can see the screen of the machine 
operator during this time, but can no longer perform any operations.

Only after confirmation by the machine operator can the service engineer see and remotely 
control the screen of the machine.

If, for example, the service engineer copies a file from the system of the machine operator to 
his system, the following window is displayed:

Figure 4-30 Copying files
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Resuming the file transfer
If a data transfer is interrupted by a temporary network fault, the copying procedure is resumed 
automatically when the connection is established again. During the network failure, the 
"File Transfer" window is deactivated and the service technician informed accordingly. As soon 
as the network fault has been corrected, the file transfer is automatically resumed as of the 
last byte transferred successfully.

Figure 4-31 File transfer interrupted

The transfer can also be continued manually in a later, separate session if the connection 
cannot be re-established during the current session.

The service engineer must start the copying procedure to the same target directory again. If 
the system finds the incomplete file from the previous unsuccessful transfer in this directory, 
the operation is continued from precisely this position.
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Figure 4-32 Restarting the file transfer

Note
Check the source and target files

To ensure that the source and target files are identical, the checksums are compared first. 
This calculation can take several minutes for large files (above approx. 100 MB). During this 
interval, the message "Waiting for confirmation!" is displayed in the status bar.

Creating a new directory
You can create new directories on your PC or on a remote system in the same way.

1. Navigate to the required directory level. 

2. Click the  icon to create a new directory.

3. Assign a name to the new directory.

Performance optimization of the data transfer
The data transfer rate has been increased significantly. The "speed" still depends mainly on 
the specific network configuration and the network load. The data transfer rate can also 
fluctuate substantially during the transfer.

In addition to the progress bar, the current percentage and transfer rate (KB/s) can be observed.
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Figure 4-33 Data transfer performance

Display of the file transfer in the log
The actions performed by the service engineer are shown in the dialog below the list of 
participants in the log.

Log window of the file transfer
File The log window of the file transfer opens automatically when the service engineer performs an 

action. 
The window can also be shown or hidden via the "Conference > File Transfer Log" window.
The directory and the name of the file to which the actions performed by the service engineer refer, 
are displayed in the window.
The log settings can be specified. 
Further information can be found in the Commissioning Manual SINUMERIK Integrate AMC, AMM/
E, Chapter: Configuring Access MyMachine/Ethernet (AMM/E), activating functions
 

Action Shows the type of action.
Status Shows the current status of the action.
Sequence Shows the progress as a percentage and as a progress bar. A progress bar and percentage is also 

shown in the lower part of the window.
Cancel The machine operator can cancel the action via the icon.
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The log is shown automatically when the service engineer starts the file transfer. Irrespective 
of this, the machine operator can open and close the log manually: 

1. Call the "Conference" > "File transfer log" menu.
The log is displayed in the lower window and shows the current status.

2. During the file transfer, in addition to the name of the current file, the performed actions, 
the status, a progress bar and an icon to cancel the file transfer are also displayed in the 
log window.

Note

In the "Settings" menu, you can specify whether the file functions performed during a session 
are also to be written to a log file.

Further information can be found in the Commissioning Manual SINUMERIK Integrate AMC, 
AMM/E, Chapter: Configuring Access MyMachine/Ethernet (AMM/E), activating functions

Cancel file transfer
1. Click the  icon to cancel a running file transfer.

A confirmation prompt is displayed.

2. Click "Yes" to irrevocably abort the file transfer.

Figure 4-34 Cancel file transfer

Deleting files
1. Select the directories or files to be deleted.

2. Right-click to call the "Delete file" menu command. 

Note

If a directory or a file with write protection is to be deleted, the following prompt is displayed: 
"File is write-protected, do you still want to delete it?"
● Click "OK" to delete the message. 
● If you no longer want to receive such messages, activate the "Use on all in the operation!" 

checkbox before confirming.

No other actions can be performed during the deleting procedure. 
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Assigning attributes
As a remote user, you can change the attributes of transferred files or directories: 

1. Select the appropriate file or directory. 

2. Right-click to call the "Set attributes" menu command. 
The setting dialog then opens for the attributes of the selected element (file or directory). 

3. Set the required attributes via the checkboxes. 

4. Click "OK" to confirm the settings.

Figure 4-35 Setting attributes for Windows

Ending the file transfer
The file transfer can be ended in several ways: 

● The conference owner closes the file transfer via the  icon.

● The owner closes the file transfer and ends the conference.
The file transfer and the running operations are terminated. 

● The machine operator leaves the conference. 
The "File Transfer" window is closed. 

4.7.4 Remote STEP 7 via the Internet
With the aid of the Remote STEP 7 function, as a remote user, you can execute all of the 
functions in the SIMATIC Manager.

Remote STEP 7 is available on SINUMERIK Operate under Linux.

Requirements
● The SIMATIC Manager (supported versions 5.4 and 5.5) must be installed on the local PC.

● The Service Engineer Client must then be installed. 

● The "Commissioning engineer" or "Service engineer" must be assigned. 

● The client on the machine operator side must support Remote STEP 7. 
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● The network interface of the SIMATIC Manager on the PC must be adapted. 

● The "STEP 7 via the Internet" function is updated,
further information can be found in the Commissioning Manual SINUMERIK Integrate AMC, 
AMM/E, Chapter: Configuring Access MyMachine/Ethernet (AMM/E), activating functions

Changing the network interface of the SIMATIC Manager
The network interface of the SIMATIC Manager must be changed before the "Remote STEP 7" 
function can be used. 

1. Call the menu "Tools > Set PG/PC interface ..." in the SIMATIC Manager. 

Figure 4-36 Set PG/PC interface

2. The "Set PG/PC Interface" dialog opens. 

3. Click the "Access Path" tab. 
In the "Interface Parameter Assignment Used" list, navigate to the "RemoteS7" interface 
parameter assignment and select the appropriate entry. 
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4. Click "Diagnostics..." if you want to test the interface parameterization.

Figure 4-37 RS7 access path

5. The Diagnostics dialog then opens.
Click "Test".  The result is displayed in the Diagnostics dialog.
Click "OK" in both dialogs.

Figure 4-38 Diagnostics result
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Starting remote STEP 7
1. Click the "RS7" icon to remotely access the control.

Figure 4-39 Remote STEP 7

2. The function start depends on the default setting: 

– Remote STEP 7 is active after a short time when the "Always request permission" 
function is selected. 

– If the "Always request permission" function is not selected, the machine operator must 
permit access. 
If the machine operator presses the "Yes" softkey, access is permitted.

Figure 4-40 Granting permission

3. If the machine operator presses the "No" softkey, access is denied for the remote user.
The remote user receives the following message:

Figure 4-41 Remote STEP 7 rejected
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Closing remote STEP 7
1. Check that no operations are in progress in the SIMATIC Manager. 

2. Click the "RS7" icon again to end the remote access.

3. Confirm the prompt with "Yes" if you really want to terminate the function.

4.7.5 Transferring the conference leadership
As conference owner, you can transfer the conference leadership to another, observing service 
engineer. The owner role therefore switches to another operator. 
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Procedure
1. As conference owner, click the icon  "Leadership transfer" the line of the service 

engineer to whom you want to transfer the leadership. 

Figure 4-42 Transfer of leadership

After calling the function, the following message appears on your PC: 

Figure 4-43 Waiting for confirmation

The following query appears on the PC of the selected service engineer: 

Figure 4-44 Confirmation

2. The observing service engineer must click the "Yes" button to take over the conference 
leadership.

Note

If the observing service engineer rejects the transfer of leadership with the "No" button, an 
appropriate message appears on the PC. 
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3. As former conference leader, you must then confirm the transfer. 
If the "Always request permission" function is not active, the machine operator must also 
confirm the transfer of leadership. The message "Waiting for confirmation from the machine 
operator!" appears on your PC and on the PC of the next conference leader.

4. The machine operator agrees to the transfer of leadership. 
The conference leadership is then transferred to the desired observing service engineer. 
The changed user roles are updated accordingly in the list of participants. 

Note
Rejecting the transfer

If the machine operator rejects the transfer, you and the observing service engineer receive 
the following message: "The transfer of leadership has been rejected by the machine 
operator!"

4.7.6 Downloading/deleting the session recording
You can record a remote access. The recording is then stored on the server as an event entry. 
In this way, you can download and view the recorded session at a later point in time.

Prerequisite
The "Automatic recording of the meeting" function is updated,
further information can be found in the Commissioning Manual SINUMERIK Integrate AMC, 
AMM/E, Chapter: Configuring Access MyMachine/Ethernet (AMM/E), activating functions
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Downloading the session recording
1. Select the "Machine events" entry on the "Machine information" tab. 

Figure 4-45 Machine events

2. The filter area of the machine events is displayed.
Make the required filter settings and click "Filter".
Detailed information on the filter settings can be found in the Function Manual "SINUMERIK 
Integrate AMC, AMM/E", Chapter: Filter and display machine events.

Figure 4-46 Machine events filter

Access MyMachine/Ethernet (AMM/E)
4.7 Using functions

Analyze MyCondition (AMC), Access MyMachine/Ethernet (AMM/E)
Operating Manual, 06/2017, A5E33520373B-AE 57



3. After filtering, all machine events are listed that match the filter settings.
Search for events of the "Session recording" type.

Figure 4-47 Machine events list

4. Click the  icon in the line of the required session recording. 
The session recording data is displayed.
The following formats are supported:

– MPEG

– AVI

– WMV (Windows Media Video)

– FLV

– Original (RFB)

5. Click on "Download" if you want to download this session recording locally.

6.  Set the local directory in which you store the session recording. 

Figure 4-48 Session recording, data display

Access MyMachine/Ethernet (AMM/E)
4.7 Using functions

Analyze MyCondition (AMC), Access MyMachine/Ethernet (AMM/E)
58 Operating Manual, 06/2017, A5E33520373B-AE



Note
Playing the session recording on the PC

The recorded sessions must be opened on the PC with a program that supports the converted 
formats. The Windows Media Player is active on the Windows system per default. Select the 
Windows Media Video (WMV) format to ensure error-free playing.

- OR -

Use the free VLC Media Player.

Deleting the session recording
1. Select the "Machine events" entry on the "Machine information" tab. 

All the machine events are then displayed in a list. 

Figure 4-49 Machine events

2. Search for machine events of the "Session recording" type. 

3. Click the  icon in the line of the required session recording. 
The recording is deleted. 

Figure 4-50 Deleting the session recording
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4.8 Selecting the window display
After logging in, the "Window" menu is activated and provides the following options.

Overview

Table 4-3 Editing the window

Action Description
Close Closes the window that has just been selected.
Close all windows Closes all open windows.
Split Adjusts the size of the opened windows so that they share the available space.
Cascade Displays the opened windows one behind the other.
Next Changes to the next open window.
Previous Changes to the previous open window.
  n <window 
name>

Changes to the open window with <window name>.

Figure 4-51 Editing the window
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4.9 Network interruption
If a network interruption occurs during an active conference, this is indicated by a status text 
in the status line.

All the active functions are terminated internally and AMM/E makes cyclic attempts to 
participate in the conference again.

Click the "Cancel" button to terminate the connection process.

Figure 4-52 Display of the interrupted network connection
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4.10 Calling the help function
AMM SC provides two help functions:

● About AMM Service Client: You obtain information about the AMM SC application.

● Softkeys, function keys: Shows the assignment of the horizontal/vertical softkeys (HSK/ 
VSK) and function keys (F).

Assignment of the softkeys and function keys

Softkey Softkey Description
F1 HSK1 Call the softkeys and function keys help function
F2 HSK2 Participate in a conference
F3 HSK3 Leave conference
F4 HSK4 Exit AMM SC
F5 HSK5 Open login settings
F6 HSK6 Open file transfer settings
F7 HSK7 Open proxy settings
F8 HSK8 Open logging settings
SHIFT+F1 VSK1 End remote access
SHIFT+F2 VSK2 Cancel file transfer
SHIFT+F3 VSK3 Switch language
SHIFT+F4 VSK4 Show/hide file transfer log
SHIFT+F5 VSK5  
SHIFT+F6 VSK6 Switch checkbox states in confirmation prompts
SHIFT+F7 VSK7 Actuate "Cancel"/"No". Only applies to dialogs with one or two buttons.
SHIFT+F8 VSK8 Actuate "OK"/"Yes". Only applies to dialogs with one or two buttons.
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Display information via AMM Service Client
1. Call the "Help" > "About AMM Service Client" menu.

Figure 4-53 Calling the help function

The following window opens and displays information about AMM SC.

Figure 4-54 AMM SC help window

Displaying the assignment of the softkeys and function keys

Note
Use of the softkeys and function keys

In order that AMM SC can be operated via softkeys and function keys, HMI-Advanced must 
not be started in parallel in the service mode on a PCU 50. Otherwise, when a button is pressed, 
this is processed by the currently active area application of HMI-Advanced.
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1. Call the "Help > Softkeys, function keys" menu.

Figure 4-55 Calling the help function

2. The "Help softkeys & function keys" window opens and displays the information available 
via the softkeys and function keys.
Click "OK" to close the window.

Figure 4-56 Assignment of the function keys
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4.11 Ending the session

Procedure
1. Call the "Conference" > "Exit" menu to close a session.

Figure 4-57 Ending the conference

2. If actions of the service engineer are still active when leaving the session, corresponding 
messages are displayed.

3. Click "Yes" if you want to end the remote access.
The functions or applications in progress are aborted.
- OR -
Click "No" if you do not want to end the remote access.

Figure 4-58 Warning
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4.12 Ending remote access

Procedure
1. Remote access can be terminated by the service engineer and by the machine operator 

via the  icon in the "Remote access" column. 

Figure 4-59 Ending remote access

2. Remote access is terminated if the machine operator clicks the icon .
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Attachment A
A.1 List of abbreviations

Admin Administrator (user role)
AMC Analyze MyCondition
AMD Access MyData
AMM/E Access MyMachine/Ethernet
AMP Analyze MyPerformance
AMT Access MyTool ID
ASC Access MyMachine/Ethernet Service Client
ASCII American Standard Code for Information Interchange
ASP Application Service Provider-Variante
BA Operating instructions
CAM Computer-Aided Manufacturing
CF card CompactFlash Card: Memory card
CNC Computerized Numerical Control:
CoL Certificate of License
COM Communication
COM Component Object Protocol (programming model of Microsoft®)
CU Control Unit
CP Communication Processor
CPU Central Processing Unit:
DB Data Block (PLC)
DBB Data Block Byte (PLC)
DBW Data Block Word (PLC)
DCOM Distributed Component Object Model
Dbxy Data Block (e.g. B 59)
DHCP Dynamic Host Configuration Protocol: Dynamic assignment of an IP address and other 

configuration parameters on a computer in a network
DNC Direct Numeric Control
DIR Directory:
DW Data Word
FCC File Client Cache
ET Equability axis test
h Hour
HMI Human Machine Interface: SINUMERIK user interface
HD Hard Disk: Hard disk
HTTP Hypertext Transfer Protocol
HTTPS HyperText Transfer Protocol Secure, 
HW Hardware
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IAC InterActive Client
IB Commissioning engineer (user role)
IE Internet Explorer
IFC Interface Client
IH Maintenance
IIS Microsoft Internet Information Service
CT Circularity Test
MB Megabyte
MCIS Motion Control Information System
MCIS MDA MCIS Machine Data Aquisition: Machine data management
MCP Machine Control Panel:
MD Machine Data 
MHComm Machine Handler Communication
MCS Machine Coordinate System
MLFB Machine-Readable Product Code
MMP Manage MyPrograms
MMP IFC Manage MyPrograms InterFace Client
MMT Manage MyTools
MO Machine Operator: Machine operator (user role)
MPI Multi Port Interface: Multiport Interface
MRL Manufacturing Resource Library
MS Microsoft
MSDE Microsoft Data Engine or Microsoft Desktop Engine database software
MSI Microsoft Software Installation
MSTT Machine control panel
NC Numerical Control: Numerical control
NCK Numerical Control Kernel: Numeric kernel with block preparation
NCU Numerical Control Unit: NCK hardware unit
NFS Network File System
NTLM NT LAN Manager: Authentication procedure for computer networks
OB Organization block in the PLC
ODBC Open Database Connectivity
OEM Original Equipment Manufacturer
OLE Object Linking & Embedding
OP Operation Panel: Operating equipment
OPI Operation Panel Interface: Interface for connection to the operator panel
OPC OLE for Process Control
PC Personal Computer
PCMCIA Personal Computer Memory Card International Association (memory card standardi‐

zation)
PCU PC Unit: Computer unit
PG Programming device
PDA Production Data Acquisition: Production data acquisition
PLC Programmable Logic Control: PLC
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PMT Parts Monitoring & Tracking: Parts tracking
PO POWER ON
ProToolPro Configuration tool
PWS Personal Web Server
RFC Requests for Comments
ROM Read Only Memory
SC Service Client
SE Service Engineer
SEC Service Engineer Client
SEG Tool presetter
SFI or SFI RM Shop Floor Integrate or Shop Floor Integrate Resource Management
SI SINUMERIK Integrate
SK Softkey
SSL Secure Socket Layer
SW Software
TDI Tool Data Information
TC Teamcenter
TCP Transmission Control Protocol
TLCA Tool Library CA: Tool catalog data
TLCU Tool Library Customer: Customer tool catalog data
TLCUA Tool Library Customer Assemblies: Complete tools
UAT Universal Axis Test
UNC Uniform naming convention
VB Visual Basic
VC Visual C
VNCK Virtual numerical control core
WCS Workpiece Coordinate System 
T Tool
TLC Tool Length Compensation
WOP Workshop-Oriented Programming
WPD Work Piece Directory: Workpiece directory
TRC Tool Radius Compensation
WSDL Web Services Description Language
T Tool
TO Tool Offset
MT Machine Tool
TM Tool Management
TC Tool Change
XML Extensible Markup Language

Attachment
A.1 List of abbreviations

Analyze MyCondition (AMC), Access MyMachine/Ethernet (AMM/E)
Operating Manual, 06/2017, A5E33520373B-AE 69



A.2 Documentation overview SINUMERIK 840D sl
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A
Access MyMachine/Ethernet, 14
AMM/E conference call, 36
AMM/E desktop sharing, 36

Changing the window view, 39
Exit, 39
Start, 38

AMM/E file exchange
Starting on the PC, 42

AMM/E file transfer, 36
Assigning attributes, 50
cancel, 49
Deleting files, 49
Ending, 50
Permitting, 44
Rejecting, 44
Starting on the PC, 42

AMM/E function keys
Assignment, 64

AMM/E recording of the session, 36
AMM/E remote access

Changing the conference leadership, 55
Changing the network interface of the SIMATIC 
Manager, 51
Conference call, 24
Ending, 66
Ending a session on the PC, 39
Ending the conference, 65
Execute, 20
Function keys, 35
Leaving a session on the PC, 25
Leaving the session at the control, 40
Remote STEP 7, 53
Session recording, 57
with HMI-Advanced, 29
With machine PC, 32
With SINUMERIK Operate, 26

AMM/E STEP 7 via the Internet, 36
Analyze MyCondition, 13, 17

C
Client setup

AMC directory, 15
AMM/E directory, 15

D
Downloading the AMM/E session recording, 57

F
Function keys

AMM/E, 62

G
Grant screen enable for remote access, 38

I
Icons in AMM/E

Status bar, 21
User role, 20

S
Screen enable, 36
Starting remote STEP 7, 53

U
User roles in AMM/E, 20
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